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Welcome to Amicus Attorney 
 

Welcome to Amicus Attorney®, an AbacusNext product. 

Amicus Attorney helps you manage your files, organize your calendar, keep 
notes, contact people, be on top of your incoming and outgoing communica- 
tions, do research, record the time you spend on your activities, and more. 

By using Amicus Attorney, you can focus on the substantive and innovative 
aspects of your practice while Amicus does the background tasks for you. 
Whether you are an independent legal professional, or a member of a small, 
mid-size, or large firm, Amicus Attorney will work for you. It is designed for 
firms of any size or area of practice. 

Amicus Attorney provides all the core functionality legal practitioners need, 
including files, time entries, contacts, communications, notes, document 
management, calendaring, tasks, document assembly, a library, and the 
powerful DO™ button. It supports unlimited custom fields and custom 
records, multiple levels of access and security control, managed documents, 
auto-backups, and a bi-directional link with Microsoft Outlook Contacts and 
Calendar information. In addition, it integrates with Amicus Accounting and 
other popular legal accounting programs, and provides links with a variety of 
other products. Microsoft SQL Server is used to host the Amicus Attorney 
Firm Database. Amicus Attorney is well suited to the needs of small to large 
firms. 

 
About this guide 

This Getting Started Guide introduces some of the many features of Amicus. 
It describes a few simple procedures for you to try. We highly recommend that 
you take the time to read this short manual! 
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Online Help is available as you work with Amicus—from the Help menu, by 
pressing <F1> on your keyboard, or from the Help Center in your Amicus 
Office. The User Help explains in detail how to use Amicus, and the Adminis- 
trator Help contains detailed instructions on firm settings and administration 
of Amicus. 

 
Terminology 
• A Firm Member may be an “Active” or “Former” member of the firm. 

Active Firm Members can be assigned to records, but Former Firm 
Members cannot. Active Firm Members are eligible to be licensed to use 
Amicus Attorney and be further designated as a Timekeeper, a Librarian, 
and/or an Administrator. Each designation provides additional rights and 
privileges. 

• An Amicus Administrator is a Firm Member who has access to firm setup 
and administrator functions and utilities. 

 
Document Conventions 
The following typographical conventions are used in the documentation: 

• Text that you should enter exactly as printed is shown in Courier font, e.g. 
7/28/2016. 

• Keys that you press are shown in uppercase within angle brackets, e.g. 
<DELETE>. 
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Using Amicus for the First Time 
 

This guide assumes that: 

• Amicus Attorney has been installed on your firm’s server, and your 
Amicus Administrator has provided you with the applicable server identi- 
fication (only necessary in a multiple server environment), the Firm ID, 
and your personal User ID and Password. 

• Amicus Attorney has been installed on your workstation. 

NOTE: If you are an Amicus Administrator, see the Install Guide and online 
Administrator Help for details on installing and setting up Amicus for the 
firm. 

 
First time login 

Once Amicus is installed, you can start the application. This section explains 
the login steps in detail, and how to set your Password. 

First, choose Amicus > Amicus Attorney in your Windows Start menu. Or, 
double-click the Amicus Attorney icon on your Windows desktop. 

NOTE: A prompt to allow Amicus Attorney through Windows Firewall might 
appear. If so, click Yes. 

The Amicus Attorney Login dialog appears. 
 

Firm ID, User ID, Password, and Server 
Your Amicus Administrator provides you with the Firm ID, your User ID, and 
your initial Password. Type this information in the Login dialog. Remember 
that your Password is case sensitive. If you have forgotten any of your login 
information, please speak with your Amicus Administrator. 
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Your system administrator may have provided you with remote access to your 
firm’s network.For more information, see the User Help. 

Then click Login. The window opens to the Dailies module when you initially 
use Amicus Attorney. You may change this behavior through your My Appli- 
cation - Defaults On Login preference. 

 

 
Setting your Password and other personal information 

For security, you should change your initial Password as soon as possible, to 
one of your own choice. Also adjust your other personal details if necessary. 

1 Choose Preferences on the navigation list of the Office window. The Pref- 
erences view appears. 

2 Click General > My Profile. 

3 Click Edit to the right of your name in the My Profile view. Your Person 
Edit dialog appears. 
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4 In your Person Edit dialog, you may adjust your name, communications, 
and address information. 

Ensure that you have a Primary E-mail address specified in the Commu- 
nications section, so that you can receive e-mail Reminders and Change 
Notifications about upcoming or changed Events. 

5 To change your password or User ID, click Office Access. The Office 
Access dialog appears. 
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Change your User ID if you like. User IDs are not case sensitive for 
purposes of logging in. 

Type your initial password in the Old Password box, type the new one in 
the New Password box, and type the new one again in the Verify box. 
Passwords are case sensitive, and must be at least eight characters long. 
Security experts recommend that a password should include at least one 
uppercase or lowercase letter, at least one number, and at least one punc- 
tuation character. It is also recommended that a password should not 
contain your User ID nor any part of your full name. 

When you are finished, click OK. 

NOTE: The lower part of the Office Access dialog enables you to grant 
other Firm Members access to your Office. 

If you have forgotten your password, please ask your Amicus Administrator to 
give you a new one. 

 
Exiting Amicus 

When you have finished your work for the day, you can exit Amicus Attorney 
by choosing Exit on the File menu in any module. This automatically closes 
any dialogs or secondary windows that you might have open. 
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Using Amicus 

There are many ways to navigate to your records, access commands, work 
with lists, and so on. The Amicus main window varies in appearance from 
module to module but always contains some common elements. 

The Amicus Navigation Pane helps you to switch between modules, and filter 
the Index lists of items. It may also provide additional controls and informa- 
tion. 

 

The name of the module is identified at the top. 
 

 
The control panel in the middle section provides 
various filter controls, navigation lists, date assign- 
ment mini-calendars, commands, information, etc., 
appropriate to the current view. Secondary windows 
and dialogs may also have a control panel. 

 

 
The module navigation buttons at the bottom 
enable you to quickly switch modules. Note that you 
can drag the divider above the Office button 
downward to make more space for the control panel 
section—the wide buttons will change to icons across 
the bottom. 

 

 

 
The Amicus Menu Bar, at the top of windows, provides access to the tasks, 
features, and tools appropriate for that window. 
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What’s next? 

Here are some of the things you might want to do now, and where to look for 
assistance: 

• Would you like to know some of the things Amicus can do for 
your practice? 
To create a File, Contact, Appointment, To Do, Note, or Favorite, see the 
introduction to these features in Chapter 3, “Here’s what Amicus can do 
for you”. For additional features, see Chapter 4, “Amicus is more than a 
practice management tool”. 

• Would you like to start inputting your practice information? 
Before you begin using Amicus for your real work, your Amicus Adminis- 
trator should set up and customize features for your firm. You need to set 
your personal preferences. This is introduced in Chapter 5, “Getting 
Amicus to work the way you do”. 
For details about customizing Amicus for your own use, and about 
creating records in Amicus, see the User Help. 
If you have existing practice information in another application, it may be 
possible to import it via one of the available third-party links—see 
“Exchanging information with third-party products” on page 43. Or, you 
may wish to take advantage of the Amicus Import wizard available to your 
Amicus Administrator. 
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Here are some of the things that Amicus can do for you: 

• Amicus informs you each day about the state of your practice, important 
firm information, and the world around you. 

• Amicus manages your files. 

• Amicus keeps track of your billable time. 

• Amicus organizes your appointments and tasks. 

• Amicus keeps track of the people you deal with and makes communi- 
cating with them simple and efficient. 

• Amicus allows you to take notes, send notes, and convert notes to other 
types of records (such as a phone call record). 

• Amicus keeps your research materials organized and at your fingertips. 

• Amicus lets you search across all types of records: Files, People, Events, 
Communications, Notes, etc. 

• Amicus lets you organize your “favorites” for easy access. 

• Assistants and colleagues can use Amicus to work closely with lawyers. 

• Amicus helps legal practitioners work together. 

This chapter explains the ways in which Amicus helps you organize your 
practice. When you have read this chapter, you will be ready to add your own 
practice information and start using Amicus. 
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Keep you informed 

The Dailies module answers the question: What is going on today? It provides 
daily information about your practice, your firm, your legal community, and 
your world. We recommend that, in your preferences, you set this module to 
open first by default. 

You can view the Dailies module at any time by clicking Dailies on the Amicus 
Navigation Pane. The left side of the Dailies window displays the control 
panel. It includes a list of Dailies Pages, which include the Dashboard Pages 
(e.g. My Desktop 1), Today’s Practice Reminders Page, Today’s Overview 
Page, Firm News Page, and personal Web Pages. When you click on the name 
of a Dailies Page, its details appear on the right side of the Dailies window. 

Today’s Practice Reminders alert you to important items about the state of 
your practice. For example, they notify you when you have not done work on a 
File for a certain number of days, have not kept in touch with Contacts, or 
have not posted any Time Entries for the previous day. The list can be 
refreshed to keep you up to date on the status of items. 
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Dashboard Pages (such as My Desktop 1) can display a variety of interactive 
Amicus data and/or external information at a glance. You can customize 
Dashboard Pages that reflect the type of information that is most important or 
relative to your day-to-day practice. You can use the provided Dashboards or 
design your own from a variety data list views, summaries, tools, or your 
favorite websites, new item data entry, and much more. 
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The Dailies module includes a Today’s Overview view, which provides infor- 
mation on your key practice issues for the day, including Appointments, 
outstanding To Do’s, and outstanding Communications. 

 
 

 
 

The Dailies module can be set by your Amicus Administrator to display a Firm 
News Page, which provides your firm with a method of distributing important 
firm news and information to every Firm Member each day. Whenever 
something concerning the firm needs to be communicated, this will be the 
place to do it. It can be used as a Home Page for your firm. 

You may also designate a Dailies Page as a portal for accessing online infor- 
mation through Web sites that you have personally selected. 

It is well worth your while to read the Dailies carefully at least once each day. 
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Manage your files 

The Files module manages all of your client matter files. The Files module also 
provides you with a variety of tools to work with this information. 

When you open the Files module, you see the Files Index. It displays your files 
alphabetically in a familiar-looking expansion folder. 

 
 

 

 
There are several ways to locate a File in the File Index list. You can simply 
scroll through the Files Index list to find a File, or you can type the beginning 
of a Short File Name in the box above to jump directly to that part of the list. 

You can also use a variety of filters to see an appropriate set of Files in the list. 
For instance, to see only your Files of a particular type in the list, select a File 
Type in the panel at the left. 

Or, you can search for a File by using the QuickFind feature. 

All index views can be customized from the right-click commands, Show 
Fields and Show Group By. 
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File details 
To view the details of the File, select the File in the list, and then click Open. 
Or, double-click the File in the Index. The File Details window appears. 

 

 
The File Details dialog shows a list of the People assigned to the File, and 
information about the Person currently selected in the list. For example, you 
can view a Person’s Business Card, showing their address, phone number, and 
e-mail address, and from there you can quickly contact the Person by phone, 
fax, or e-mail. The list includes both Firm Members and Contacts. 

You can also keep track of the Person’s role and other attributes on the File. 
For example, the Person might be a Lawyer, Client, Party, Witness, etc. 

There are several brad views of special information available in the File 
Details window. The brad is the simulated clip that attaches various pages 
(views) of information to the File. To display a particular brad view, use the 
navigation list in the control panel or click the brad clip. 

In the various views of the File Details window, you can view or work with a 
variety of information related to the File, such as a File Summary, Notes, asso- 



Manage your files 

15 Amicus Attorney Getting Started Guide 

 

 

 
ciated Documents, Related Files, Research, To Do’s and Appointments, 
Communications, Time Entries, and Custom and administrative information 
relevant to the File Type. 

The Admin > General and Accounting views of the File Details window hold 
your firm’s administrative information about the File, such as the Client and 
Matter Name and ID, the Short File Name used to reference the File, and the 
File Status. You can even add instructions on how issues that arise on the File 
should be handled while the Responsible Lawyer is away. 

 

 
In the Files module, you can organize all the tasks for a given transaction. You 
can review everything that has been done and needs doing. You can see all of 
the information for the Files you are working on with your colleagues, 
including the work others have done. 
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Keep track of your time 

Amicus takes much of the drudgery out of recording your time and filling in 
Time Sheets. 

There are several advantages to using Amicus for this process. It’s faster, even 
if you are not an experienced typist. For instance, Amicus provides lists of 
Activity Codes and Time Entry categories, which you can select by clicking the 
mouse. 

TIP: For easy selection, you can specify your commonly used Activity Codes in 
your Preferences. 

Ideally, you should not have to fill in any information at all. In many situa- 
tions, Amicus already knows what File you’re working on, the details of the 
Client, what you were doing, and how long you took. If the activity has a flat 
rate assigned to it, that information is also known. When you finish a task, 
Amicus can then present a Time Entry ready for you to approve. 

Here is a time entry: 
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Time Entries accumulate during the course of the day on a Time Sheet, which 
you can review prior to posting them to the firm’s accounting system. A day’s 
Time Sheet looks like this: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In the Monthly view, you can see posted and unposted Time Entries for a 
particular month. Totals are given for each day and the month’s accumulated 
time and dollar amount, with a breakdown of posted and unposted Time 
Entries. You can also click a particular day to see the totals for that day. 

The Time module shares the information with the Files module—you can see 
all of the Time Entries you have recorded on a File from the File’s details 
window. 

Another advantage of recording time is that Amicus can warn the lawyer 
responsible when a Time Entry has not been created on a File within a 
certain period of time. Therefore, they can keep on top of Files that require 
regular attention. 

Because Amicus knows how much time you have spent on each File, what 
activities you performed, and the date on which you recorded the time, you 
can search through all of your past Time Sheets to find very specific 
information. 
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The Time Entry Assistant makes it easy to ensure that Time Entries have been 
created for all relevant items. It quickly locates items for which Time Entries 
have not yet been recorded: Done To Do’s, past Appointments, Phone Calls, 
E-mails, Notes, and Documents. Several methods are available for creating 
Time Entries for the items in your list, and for assigning File(s) to items 
without a File. You may limit the search by date range, and some additional 
exclusion options are available. 

 

Amicus also keeps track of how many billable and non-billable hours you 
have spent altogether, and projects your total billable hours for the year. You 
can see your average billable hours per day, week, or month, and then 
compare this year’s figures to last year’s and see what you need to do to meet 
your targets. 



Organize your calendar events 

19 Amicus Attorney Getting Started Guide 

 

 

 
 
 

Organize your calendar events 
The Amicus Calendar keeps track of your daily appointments, and displays 
deadlines and to do’s for each day. Appointments and To Do’s are collectively 
referred to as Events. 

 

 
 

You can easily reschedule an Appointment without typing—you can “drag and 
drop” it onto another date in the Calendar. You need only fill in the details of 
repeating Appointments (such as regular meetings) once, and let Amicus 
schedule them at the required intervals in the future. 

When you create a new To Do or Appointment in the Calendar, you may 
assign it to one or more Files. If the Event involves Contacts or other Firm 
Members, it is automatically added to their records too. The Event can then 
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also be viewed on the assigned Files and the Contacts. In this way, the 
Calendar shares information with other Amicus modules, displaying the same 
practice information in a different context. 

Similarly, every Phone Call you make is added to a list of phone calls for each 
day. A record of each Phone Call is also shown in the relevant File and Contact 
details. 

When the time for an Appointment is approaching, Amicus gives you advance 
warning. When an Appointment is over, you are reminded to complete a Time 
Entry. Amicus makes this as painless as possible—most of the details are 
already filled in. 

To Do’s are carried forward from one day to the next, so that nothing gets left 
behind. When you finish a To Do, and mark it Done, Amicus can automati- 
cally create a Time Entry—again, much of the information has already been 
filled in for you. 

You can create one or more Calendar Profiles in order to quickly display the 
schedule for yourself or several People in the desired view (Day, Week, Date 
Range, Month, or Lists). 

Or, simply check one or more boxes in the control panel to see the schedules 
of selected members of your workgroup. 

The handy Date Calculator (available from the Tools menu) assists you in 
finding a specific date that meets your criteria for a meeting, or in calculating 
the amount of time between two given dates. 
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Organize your Tasks 

The Tasks module gives you a centralized place to get organized and get things 
done. It couldn’t be easier to make a list of what you have to do—just type and 
press return. Each task is a To Do record in Amicus, and you will never lose 
track of it. Quickly jot down new tasks as you think of them and refine the 
details later. 

The Tasks list may be filtered in many useful ways, and displays To Do’s for 
yourself and/or others in Simple, Detailed, or Timeline format. You may 
define customized views via Tasks Profiles. 

List views provide an editable row for quick and simple creation of new To 
Do’s or editing existing To Do’s, without needing to open the Event Details 
window. 

 

To show Tasks that you created for others (but are not assigned to), select the 
Others By Me checkbox. You can check on the status of a To Do assigned to 
others by using the Status Inquiry function. A Status Inquiry is an e-mail 
message to be sent to the Firm Members assigned on a To Do. A message will 
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open in your e-mail provider, addressed to those Firm Members and with a 
subject of “Status Inquiry” followed by the To Do's Title. 
A Timeline view displays the To Do’s chronologically across the screen. 

 

 
Keep track of your contacts 

 

The People module displays information about the Contacts you keep in touch 
with, including their name, company, addresses, phone numbers, e-mail 
addresses, and web addresses. If any anyone changes the details of a Contact, 
the information shown is automatically updated for everyone. 

A Firm Directory is also available. Use the option in the control panel to 
switch views. 

When you first open the People module, you see the People Index, which 
displays an alphabetical list of your Contacts by default. This list displays their 
name, company, phone number, the date that the Contact was last contacted 
by you, and a Marked or Unmarked flag that can be used to filter People in 
the list. 



Keep track of your contacts 

23 Amicus Attorney Getting Started Guide 

 

 

 
 
 

 
 
 

There are several ways to locate a Person in the People Index list. You can 
simply scroll through the list to find a Person, or you can type the beginning of 
a Person’s last name in the box above to jump directly to that part of the list. 

Or, you can search for a Person by using the QuickFind feature. 

A Contact can be defined as an Individual or a Company. By linking an Indi- 
vidual to a Company record, you reduce the need to enter addresses and 
communications information more than once, and simplify the maintenance 
of business contact information. 
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Person details 
The Person Details window shows detailed information for the selected 
Person. 

 

 
Their Business Card, at the top left, displays the primary contact information 
for getting in touch with the Person by phone, fax, or e-mail. You may attach a 
photo of the person for display in this window. The date of your las t contact 
with the Person is shown at the top right, and you can set an automatic 
reminder for keeping in touch with them. 

The various views of the Person Details window show: 

• Notes associated with the Person 

• the Files the Contact is associated with 

• the Firm Members who list this Contact in their People Index 

• Groups that they are assigned to—You can assign People to Groups so that 
you can easily see, for example, a list of all of your Clients, Consultants, or 
everyone you play squash with. 

• People this Contact is related to 
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• Files this Contact has referred to the firm 

• Events (Appointments and To Do’s) involving that Contact 

• Communications involving the Contact—Phone Calls, Phone Messages, 
E-mail, Faxes, and Letters 

• Documents associated with the Contact 

• Custom information 

 
Enhance the way you use the phone 

Being on the phone is an integral part of your day, so it’s an integral part of 
Amicus. With one hand holding the receiver, you only have one hand free for 
all the other things you are doing simultaneously—like making Notes, looking 
up a record of previous Phone Calls to the Person, while keeping an eye on the 
time. 

 
Phone Calls 
Making a record of your Phone Call is easy. For example, you can click the 
New Phone Call button on a Person’s Business Card (on a File or in their 
People record), or simply select a record in one of the Communications lists 
and use the right-click command. Amicus displays a Phone Call Details dialog 
with as much information as possible already filled in, and the Timer running 
to keep track of the time you spend on the call. 
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From the Phone Call Details dialog, you can perform a number of tasks in 
addition to recording information about the call. You can display a list of 
previous calls with the Person, associated with the File, or made on the same 
date. You can create a Phone Message, a follow-up To Do, or a Time Entry, or 
convert the Call into a Phone Message. You can even record a conference call 
involving multiple Files and People. 

 
Phone Messages 
You can send another Firm Member a Phone Message that includes all 
pertinent information, such as the date of the call, time of the call, name of the 
Person who called, phone number, associated Files, and text message. You 
can also indicate whether the phone call was urgent, whether the caller 
expects a return phone call, etc. The Firm Member receiving a Phone Message 
can even forward it to another Firm Member. 

 

You can create Phone Messages for your own voice mail, so that all your 
messages are stored in Amicus and appear in a single list. A handy preference 
makes it easy to have messages addressed by default to yourself, or to 
someone you work with. 

When you receive a phone message, you will be alerted by a sound, providing 
that you have set the appropriate preference. 
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Integrate your e-mail 

With e-mail being an essential tool for running your practice, Amicus features 
an integrated solution with Microsoft Outlook or Exchange that allows you to 
not only send and receive e-mail within Amicus, but also save and associate 
e-mail with your Files and Contacts on a record-by-record basis. Your prefer- 
ence settings can be used to determine how e-mail is saved, displayed, 
deleted, and arranged. 

Once the E-mail Link is set up, Amicus will detect all e-mail sent to or received 
from your Outlook/Exchange mailbox. You can set Amicus to automatically 
associate and save e-mail should it recognize the e-mail address. Any e-mail 
sent directly from a Contact or File record is automatically saved on that 
record. 

 

The E-mail Details dialog provides functions and data that relate to integra- 
tion of the e-mail with your Amicus practice information, including associated 
People and Files, a follow-up To Do, and a Time Entry. Attachments can be 
saved separately and attached as Amicus Documents to the relevant Files. 
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Manage all your communications 

The Communications module lets you manage incoming and outgoing Phone 
Calls, Phone Messages, and E-mail. 

 

 
You can use the Communications module to view the details of outstanding 
communications, ensuring that you never overlook an unreturned phone 
messages or e-mail regardless of how long ago it was. The Communications 
module is a handy place for an assistant or receptionist to work from. 

In addition to the Communications module, Communications lists are shown 
in File and Contact records, the Calendar Day view, and the Today’s Overview 
Page in the Dailies. 

An optional preview pane at the bottom shows details of the currently selected 
Phone Call, Phone Message, or E-mail without your needing to open the 
Details dialogs. Review all your Communications quickly and easily. To turn 
this feature on or off, choose Preview Pane from the View menu. 
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Help you with your research 

The Library module is a unique knowledge management tool that stores a 
database of all the resource materials that your team has accumulated. Using 
the Library, you can keep all your personal and your firm’s legal resources at 
your fingertips. Resources can be just about anything. For example, they can 
include documents, memos, computer files, online services, or Web sites. 

The Library module works much like a traditional library. The Library 
contains Sections. Each Section may include further Sections. A Section 
contains one or more Library Pages. A Library Page provides valuable infor- 
mation about a particular resource, and it enables you to open and work with 
that resource. 

You can easily locate material by browsing through the Library in the Catalog 
view. The left side of the view displays the Navigation section, and the right 
side displays the Page Summary for the selected Page. 
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The Amicus Library is capable of holding immense amounts of information. 
To enable you to access all these resources quickly and efficiently, the Library 
must be organized to suit you and your practice. The Library structure is 
incredibly flexible. You have full control over how you set up your Sections 
and Pages. You can have as many levels of Sections as you wish, and can even 
mix Sections and Pages on the same level. Library Pages may be designated as 
either Firm or Personal, and can be associated with Files for easy reference. 

 
Paid Services 
The Library module also keeps track of the Paid Services your firm uses. A 
Paid Service is any service you might use that charges a fee for its use. In 
Amicus, a log reports who has used each Paid Service, when, and on which 
File. 

 
Add, send, and convert notes 

Amicus enables you to create Notes, and associate them with Files, Contacts, 
Events, or Library Pages. You can even send them to Firm Members as 
Stickies. 

Record anything at any time as a Note. No details dialog to call up, no buttons 
to click, no selections to make—just get that thought down while you are 
thinking of it. Then later, you can cross-reference the Note to a particular File, 
or convert it into a different type of record. 
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Notes that are not associated with other records remain in the Notes module. 
If you do associate a Note with other records, it is instead displayed in the 
appropriate modules. For example, if you associate a Note with two Files and 
a Contact, the Note will be displayed on those Files and Contact details. 

You can even convert a Note into a different type of record: a Phone Call, 
Phone Message, To Do, Appointment, Time Entry, or E-mail. 
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If you send a Note as a Sticky to a Firm Member (from New > Sticky on the 
File menu), it arrives on their screen looking like this: 

 

 
The Firm Member can then view the details, reply, associate it with other 
records, or convert it to another type of record as mentioned earlier. 

 

 
The Notes module is an invaluable tool for the busy professional. 
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Query your data 

The Search function provides a powerful and flexible method of searching 
globally across multiple types of Amicus records including Files, Contacts, 
Events, Time Entries, Communications, Notes, Documents, and Library 
Resources. 

You can even save Advanced Search Definitions so that you and other Firm 
Members can run the same or similar search again later. 

 

When you run a search, the results are displayed in a printable list view. You 
can open individual records in the list to view their details. 

To run simple searches, you can use the Basic options; to run more complex 
searches, you use the Advanced options. For example, because your Library 
can hold a vast amount of information, the resources within it can be filtered 
and searched by using a combination of criteria such as title, keywords, 
summary, notes, date, author, and page types. Amicus can also search the 
text of documents linked to Library Pages and Documents (provided your 
Amicus Administrator has properly configured the relevant document 
folders for full text indexing). Saved Library queries can also be associated 
with Files for easy reference. 
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Favorites 

The Favorites module of Amicus Attorney provides a convenient way to access 
the records you use frequently. For example, you might add the Files you are 
currently working on this month to your Favorites list. 

 

 
 
 
 
 
 

You can add one or more items to your Favorites by selecting them from any 
list in any module and either choose Add To Favorites in the Edit menu or 
from the context menu. 
From the Favorites module, you can open, edit, view, print, or create Events, 
Time Entries, or Communications for your favorite records. And, whenever 
assigning Files or Contacts to records, you can display your favorite Files and 
Contacts for quick and easy selection. 
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Help assistants work with lawyers 

Once a lawyer’s practice information is input, it can be made available to other 
Firm Members, such as the lawyer’s assistant. 

If you are an assistant, you can work from your own Amicus Office on all the 
Files that have been assigned to you. 

However, if you are an assistant who works very closely with a particular 
lawyer, you might find it more convenient to work in that lawyer’s Amicus 
Office. Once a Firm Member grants you access to their Office, you can simply 
choose Open Another Office from your Office module control panel and select 
their name. 

Similar to assistants, colleagues can be granted access to another Firm 
Member’s office. This feature is useful during vacation or other absences 
when you need someone to fill in for you. 

 
Help professionals work together 

Sometimes you are one of several professionals working on the same File. You 
can easily share File information with others in your firm. 

Let’s use an example: John and Sarah are lawyers at the same firm, working 
on the same case. John and Sarah can each access the File from their own 
Amicus Office. They can see a log of Communications on the File, access 
Documents, and see who has performed each task. In addition to this, they 
can do Calendar group scheduling, perform firm-wide searches for conflicts of 
interest, send Sticky Notes, and access the firm Library. 

 
Help you work from wherever you’re connected 

Amicus lets you work anywhere. Take your practice information with you, use 
it at home, transfer it to a pocket organizer, or access it across the Internet. 
It’s your choice. 

Log in from any desk in your office. Use Amicus Anywhere to connect from 
any Web browser. 

With Amicus, you are not tied to a place or a machine. Work where and when 
you choose. And if you get an unexpected call on an urgent matter—wherever 
you are—all your vital practice information is at hand. 
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4 
Amicus is more than a practice 

management tool 
 

In Chapter 2, you learned about the basic features of Amicus. Take a minute to 
read this chapter and you will discover what makes Amicus more than just a 
practice management tool. 

In the course of helping you manage your practice, Amicus collects a lot of 
information. The real power comes from combining the accumulated infor- 
mation with your own legal expertise. Here are the ways that Amicus uses this 
combination of facts and knowledge: 

• Amicus can assist you in performing certain tasks such as making a phone 
call, sending an e-mail, checking the status of a File, and launching 
macros written in other applications. 

• You can link time-dependent events in your calendar. 

• You can save the steps for common transactions, and reuse them in a 
subsequent File. 

• Amicus generates simple or sophisticated documents. 

• You can attach documents and other items to Amicus. 

• You can exchange information between Amicus and a number of third- 
party programs. 

Before you can use these advanced features, you need to know how to incor- 
porate your own legal experience into Amicus. This chapter gives you a brief 
overview of each feature. More detailed step-by-step instructions can be 
found in the User Guide and Online User Help. 
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Amicus lends a hand 

The tasks that you create in Amicus are Events known as To Do’s. They might 
include making a phone call, drafting a document, reviewing a File, doing 
research on the Web, or working with a spreadsheet or database. 

A To Do is generally a reminder for you to perform a particular task. However, 
in Amicus, a To Do can contain a DO button that you click to actually help you 
do the task. Take a phone call for instance. Your To Do says “Call Janet 
Bailey”. When you see the reminder on your To Do list, then you could go to 
Janet’s Business Card and find the number. Or, you could have Amicus do all 
of that for you. After all, you just want to talk to Janet. 

 

 
Imagine that the To Do says “Draft Retainer Letter”. Here is what happens 
when you click the DO button. Amicus checks your list of Assembly Templates 
for the Retainer. It runs your word processor, passes on the relevant details 
about the Client, and creates the retainer. You can tell Amicus to time the 
activity too, so when you’re done, a completed Time Entry is ready to add to 
your Time Sheet for today. 

When you want help with a certain task, you can attach instructions when you 
create it. Amicus helps you do this too. 

The instructions that you attach to a To Do are included when you save it as 
part of a Precedent (see “Precedents of common transactions” on page 39). 
Thus, for every new File that begins with sending a retainer letter, all you have 
to do is click a button. 

 
Linked Events in your Calendar 

Many of a lawyer’s tasks are dependent on other things happening, and must 
sometimes be done within a certain time frame. Tracking these time- 
dependent Events is a background activity that Amicus can manage for you. 

Amicus lets you set up a To Do in a way that you can be sure that the task 
shows up on your To Do list when it is time to complete it. This really helps 
you stay on top of the many things you must keep up with in a busy practice. 

Imagine that you have a court appearance at the end of next month and must 
file a certain document ten days before. You can create a To Do called “File 
Motion” and make it dependent on your “Court Appearance” Appointment, 
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giving it a Deadline of ten business earlier and a start date of five days before 
that. 

 

Instantly, the “File Motion” To Do appears on the correct day in your 
Calendar. If the court date is later rescheduled, your Linked To Do will auto- 
matically move with it. 

Chains of Linked Events can be much longer than this example. They might 
take a little time to set up, but you can reuse them by saving them as a Prece- 
dent. 

 
Precedents of common transactions 

Similar types of cases often follow similar procedures. In Amicus, you can 
save a series of steps as a Precedent. By doing this, you can become more 
efficient in the work you do. For example, if you are a corporate lawyer who 
frequently conducts share purchases, you might complete one or more proce- 
dures that include Appointments and To Do’s, which can be saved as a Prece- 
dent. 

These Events might include getting a retainer, reviewing the shareholders’ 
agreement, drafting the subscription agreement, and so on. To create a Prece- 
dent, select a series of Events from a File. For example, you might save the 
Precedent and call it Property Purchase - Simple. 
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To use the Precedent, open the File in which it will be applied. Then, instead 
of re-entering all the Events as previously, you just need to choose the saved 
Precedent called Property Purchase - Simple. You can optionally change the 
People assignments on the Events. After you do this, Amicus displays all of the 
Events on the new File. 

If your Precedent includes Linked Events, you will be prompted to set the 
relevant date in the Master Event and the Linked Dependant Events will be 
automatically scheduled. 



Generating documents 

41 Amicus Attorney Getting Started Guide 

 

 

 
Generating documents 

Using information from your Files and People records, Amicus can automati- 
cally generate documents for you using Merge Templates. 

 

Sometimes you need to generate a basic document such as a fax cover, memo, 
or a letter. Amicus comes with a number of sample Merge Templates that you 
can use as the basis for creating your own documents. 

Templates can be authored in Microsoft Word or Corel WordPerfect. HotDocs 
templates are also supported. Templates can be grouped into categories for 
easy selection, and can be designated for use by all or just by specified users. 

It is simple to generate a document once a Template is created. For example, a 
Fax Cover Page Template can be used by all Firm Members each time they 
need to create a fax cover page. 

You can incorporate any piece of information from Amicus into your 
Template. Such information might be short, like a Company name, or quite 
long, like a chronology of Events. 

During the document generation process you have the option of attaching the 
resulting document to an Amicus record. 

Generating e-mail messages 
You may also use a Merge Template for generating an e-mail message to one 
or more of your Amicus Contacts. When you initiate an e-mail from Amicus, 
you can choose to have the message text generated based on a template. This 
feature is particularly useful for mass mailings. A single e-mail message is 
created for each recipient. 
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Attaching items to Amicus 

You can easily attach items, like documents, URLs, spreadsheets, graphics, 
etc. to Amicus Library Pages or Amicus Documents that are associated with 
Files and/or Contacts. Installing the Amicus Tasks Toolbar at your worksta- 
tion allows you to initiate the attachment process directly from within Word, 
WordPerfect, Excel, and Adobe Acrobat or Adobe Reader. 

 

 
Alternatively, you can create the record in Amicus first and enter the location 
of the document. 

We recommend that attached documents be stored in your firm's designated 
Shared Documents location. Attachments can be viewed in their native appli- 
cation directly from Amicus for easy reference. 
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Accessing your documents on Amicus records 

You can access your Amicus Documents not only from the records they’re 
associated with (Files, Contacts, and Events), but also from a central list 
provided by the Documents module. 

 

 
Exchanging information with third-party products 

Amicus features links to a selection of third-party products, enabling you to 
exchange information between Amicus and other applications to increase 
your efficiency and promote accuracy. 

 
Amicus Anywhere 
Amicus Anywhere is an optional product for Amicus Attorney users seeking 
real-time connectivity from the browser on their iPac, PC, or Mac to their 
Amicus Files, Contacts, Phone Calls, Messages, Time Entries, and more. It 
allows Amicus users to stay connected when away from the office. You can do 
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time entries, add appointments on a file, add phone calls, etc. And it works 
both ways. If your assistant takes a phone message for you, the message 
appears in Amicus Anywhere. 

Data is transmitted securely via the cloud, between the firm’s Amicus Server 
and the user’s browser. No installation or configuration is necessary. 

 
Accounting systems 
Amicus Attorney features dynamic links to a selection of accounting system 
applications—including PCLaw, QuickBooks, Timeslips and others. A 
dynamic link between Amicus and your accounting system can do much to 
simplify your practice. Each link provides varying levels of integration, which 
may include common information being kept in synchronization, and Time 
Entries being posted directly from Amicus by Firm Members. The accounting 
links reduce the need for information to be entered twice, facilitated by 
exchange processes between the applications, in many cases automatically, 
requiring no user intervention. 

Before using the integration, your Amicus Administrator will need to 
configure and perform an initial synchronization of your practice information 
in both Amicus and your accounting system. 

For more detailed information, see the appropriate Link Guides, available 
from your Amicus Office Help Center. For a complete list of available dynamic 
links, please check our website or speak with your Amicus Administrator. 

 
Other links 
Amicus provides links to a selection of other third-party applications— 
including HotDocs, Microsoft Office (including Word, Outlook, and Excel), 
WordPerfect, Dropbox, and Worldox. Integration with smartphones is 
provided via synchronization with Outlook. 

For details about these links, see the online Help or Link Guides available 
from the Office Help Center in Amicus. 
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5 
Getting Amicus to work the way you do 

 
Amicus lets you customize the way in which information is displayed and 
organized. This increases your efficiency by providing the most familiar envi- 
ronment in which to work. In the course of using Amicus, you will discover 
which features you want to modify to fit your practice. For example, instead of 
simply having a File Type called “Real Estate”, you may subdivide this practice 
area into “Real Estate–Commercial” and “Real Estate–Residential”. 

If you are a Firm Member, you will notice that there are some things you can 
adjust and others you cannot. Your Amicus Administrator will customize 
some aspects of Amicus for all Firm Members in a way that ensures consis- 
tency throughout the firm. There are other preferences that you can use to 
adapt the program to your personal work style. 

This chapter describes briefly the areas of Amicus that can be customized by 
you and/or your Amicus Administrator. Further details on customization are 
provided in the User Guide (and in the corresponding Online Helps). 

 
Setting up lists to conform to the firm’s standards 

Amicus displays lists of choices in many places. These lists are central to the 
way that you collect and organize your practice information. They give you the 
ability to search accurately for specific information when you need to, or use 
certain types of information in reports and other documents. 

Here are a few of the places where you will find lists: 

• When you create a Time Entry, you can make selections from the Billing 
Category list, the Billing Rate list, and the Activity Codes list. Activity 
Codes are particularly useful because they provide you with a friendly 
description and your accounting software with the correct code. 
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• When you open a new File, the File Type list helps you classify the File, 

and automatically assign the related Custom Fields. Other lists help you 
organize information that the File contains. These include the Client’s 
Business Type, the method your firm obtained the Client’s business, and 
the Role of each Person on the File. 

• Events in your Calendar can be classified by Event Category. As well, To 
Do’s can be assigned a Priority. 

• When organizing your Contacts and Firm Members, you can assign them 
to various Groups. 

Your Amicus Administrator can add, edit, delete, or change the order of the 
items in all firm lists. (Some exceptions apply to system values.) 

 
Preferences & Setup 
You can set your own personal preferences for many features of Amicus. To 
open the Preferences view, choose Preferences in the navigation list of the 
Office window. For examples, see the following sections. 

 
Displaying lists in a preferred order 

You can control the default order or filtering of the following lists: 

• Files 
• People 
• Events (To Do’s and Appointments) 
• Unposted Time Entries 

Events are displayed in many areas of Amicus, such as your current To Do list, 
or a list of To Do’s you have completed. You can change the way these lists are 
sorted by default. For instance, instead of automatically sorting the To Do list 
by Priority, you could have it sorted by Deadline. You can still re-sort lists 
when you are viewing them, and control the fields that are displayed, but the 
default way they are sorted is specified by your preference settings. 

In the list of Unposted Time Entries, you could have your entries sorted by 
File instead of by time of entry. 

In some cases, you can specify which subset of the list should be displayed 
first. For example, you might specify that the Files Index list be filtered to 
show only “Civil Litigation” Files. 
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Setting defaults for new items 

 
Setting defaults for new items 

Preference settings also allow you to specify many of the defaults in new 
entries that you make. These settings allow you to use Amicus more effi- 
ciently. For example, you can set a default area code for new phone numbers, 
specify the Firm Members who will be assigned to a new File, or designate 
who the Responsible Lawyer will be on new Files. 

 
Improving your File management 

Your Amicus Administrator can customize the New File Intake Forms that are 
presented when new Files are opened. Different forms can be assigned to 
specific File Types and individual fields can be marked as required. Intake 
Forms streamline the file opening process and help ensure that all necessary 
information is captured with minimal navigation. 

Often you work on a File for a while, then set it aside for a period of time. 
There is a tendency for such Files to get buried under the paperwork of more 
urgent matters. Amicus can remind you that these Files are still around and 
that they need to be reviewed periodically. It is also handy to know whether 
you have spent more than a certain amount of time on a particular File. 

To activate these warnings for the designated Responsible Lawyer on an indi- 
vidual File, open the Admin view of the File Details. Set the Time Entry 
warnings as desired. If the limits are exceeded, a reminder will appear in the 
Today's Practice Reminders section of the Responsible Lawyer’s Dailies 
module, and will also appear as a To Do in their Calendar. You can configure 
your Preferences to set these warnings by default on new Files. 

 
Keeping better track of People 

Your People Index will quickly fill up with names. As you fill in the details of 
each new Contact, you can assign them to one or more Groups. Then you can 
display a subset for quicker searches or for group mailing lists. 

You can filter the list in the People Index window to show Contacts only, or 
show the firm directory. And if your security rights permit, you can choose to 
see all Contacts in the database. 

There are some People whom you must contact on a regular basis. Amicus can 
help you keep track of when you last contacted a Person. And if it has been too 
long, it can automatically put a reminder to call the Person in your To Do list 
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and Today’s Practice Reminders. This can be a useful business development 
tool. 

 
Fine-tuning your calendar 

Would you like to be reminded about upcoming Appointments? How many 
minutes in advance? These are the kinds of things you can customize in your 
Amicus Calendar. 

Suppose you fill in the details of a weekly meeting. This is a recurring 
Appointment. Do you want repeating Events like this to appear in your 
Calendar indefinitely? Or only the next three instances? 

When you create a new Appointment in the Calendar, do you want the default 
length of time for the Appointment to be half an hour or an hour? 

All of these, and more, are available using preferences. Fine tune your 
Calendar to make it work best for you. 

 
More 

There are many aspects of Amicus that can be set up to work just the way you 
want. Choose Preferences on the control panel in the Office module, and then 
explore the various preferences: General, My Application, Files, People, 
Calendar, Documents, Time, Communications, Library, Notes, Dailies, and 
Third-Party Link settings. 
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6 
Learning more 

 
This chapter tells you where to get information on the features of Amicus 
Attorney and how to make the most of them. 

 
Taking a tour of Amicus Attorney 

For an overview of the many powerful features in Amicus, take a feature tour 
of the program from our website at www.amicusattorney.com. 

 
Tutorial Office 

Experimenting is an excellent way to learn software. The Tutorial Office lets 
you experiment with Amicus Attorney without concern that you will affect 
your firm’s data. Indeed, the changes that you make in the Tutorial Office will 
be discarded at the end of each session, and the original sample data will be 
provided again whenever you return. 

To open the Tutorial Office, choose Open Tutorial in the navigation list of 
your Office window. The Tutorial Office opens. Now you can experiment with 
the application. Note that each time you open the Tutorial Office, its examples 
are all made current to Today’s date. That’s why it may take a few minutes to 
open. 

 
Sample Data 
The Tutorial Office provides you with sample data in each module. There are a 
number of fictional Files, Contacts, Events, Communications, Library content, 
etc., allowing you to use Amicus as it might well look in an active practice. 

http://www.amicusattorney.com/
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Special Tutorial Files 
The Files module also contains a number of special Tutorial Files. To access 
these special files from the Tutorial Office Files module, select “Tutorial” in 
the Type drop-down list in the Files Index control panel. 

Each special Tutorial File contains information and instructional text about 
how to use particular aspects of various features. The File Name identifies the 
topic. You will find Tutorial Files about File basics, People on Files, making 
phone calls, taking and forwarding Messages, e-mail integration, Calendar 
views, Appointment reminders, calculating dates, checking for conflicts, 
Milestone events, Linked events, Precedents, Notes, custom fields, Time 
Sheets, searching, document assembly, working with documents, and more. 
Open each one, review it, and experiment at your own pace. 

What’s not available 
Some Amicus functions are not available while you are working in the Tutorial 
Office. These include third-party integrations, indexed searching, and firm 
settings. Administrative functions will be available to you in the Tutorial 
Office only if you are designated as an Amicus Administrator. Document 
assembly is dependent upon your setup having been completed in your own 
Office. 

Exiting the Tutorial Office 
When you are finished, return to your own Office by choosing Return To My 
Office in the navigation list of the Office window. Any changes you made in 
the Tutorial Office will be cleared. 

If you used the Amicus Tasks Toolbar in other applications (e.g. Microsoft 
Office) while you were logged into the Tutorial Office, you should restart those 
applications after you return to your own Office. 

 
Getting help 

If you need help while you are using Amicus, you can always get assistance by 
using the Online Help. It is your main source of “how to” information about 
Amicus. 

User Help 
For online User Help, you can choose Amicus Attorney Help on the Help 
menu in Amicus. You can also select the “User Online Help” hyperlink in the 
Office Help Center. 

User Help provides detailed instructions on using the many functions of 
Amicus, including setting your personal preferences. 
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Getting help 

 
Administrator Help 
For online Administrator Help, an Amicus Administrator can select the 
“Admin Online Help” hyperlink in the Documentation list in the Office Help 
Center. 

 
Using the Help Center 
To go to the Amicus Help Center, choose Help Center on the Help menu, or 
choose Help Center in the navigation list of the Office module. The Help 
Center view provides easy access to a variety of documentation and important 
links to our website: 

• Online User Help 
• Link Guides for personal links (Outlook/Exchange, Google, Dropbox) 
• Getting Started Guide—we recommend that all new users of Amicus read 

this guide. 
• Important Support links 
• How to contact us 
• Other Resources, including how to locate a consultant and access to our 

user forum 

The Help Center provides additional resources for Amicus Administrators: 

• Online Administrator Help—use this Help for important firm and user 
setup and configuration information 

• Accounting Link Guides 
 

User Guide 
The User Guide contains over 600 pages of valuable detailed information for 
all Amicus Attorney users, including Amicus Administrators. 

This guide shows you the simplest way to perform a task. As well, additional 
explanation is given about getting around in Amicus, customizing your Office, 
using each of the modules, and completing more complex procedures such as 
setting up DO button Intelligent Assistance and Precedents, and generating 
documents using Document Assembly. 



Chapter 6: Learning more 

52 Amicus Attorney Getting Started Guide 

 

 

 



53 Amicus Attorney Getting Started Guide 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Index 
 

A 
accounting links 44 
Activity Codes 16 

list customization 45 
administration, Amicus Administrators 2 
Administrator Help 51 
Amicus Anywhere 43 
Appointments 19 

See also Events; Calendar 
assistants working with lawyers 35 
automated tasks. See DO buttons 

 
B 
billable and non-billable hours 18 
Billing Categories list customization 45 
Billing Rates list customization 45 
Business Card 24 

 
C 
Calendar module 19 

preferences 48 
See also Events 

Callback Reminders. See Follow Up To Do’s 
client matter files 13 
Clients 

See People 
Communications module 28 

See also Phone Calls; Phone Messages; E- 
mail 

Contacts. See People 
control panels 7 
Corel WordPerfect 41 
customizing Amicus 45 

 
D 
Dailies module 10 
Dashboard Pages 11 
Date Calculator 20 
DO buttons 38 
dockets. See Time Entries 
document generation 41 
Documents module 43 

 
E 
E-mail 

e-mail attachments 27 
e-mail generation 41 
E-mail integration 27 

Events 19 
Event Categories 46 
linking 38 
See also Appointments; To Do’s; Calendar 

exiting Amicus 6 
 

F 
Favorites 34 
Files 

File details 14 
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firm 

File Type list customization 46 
Files Index 13 
Files module 13 
Intake Forms 47 
 
Firm ID 3 

Merge Templates 41 
Microsoft Word 41 
mobile devices 43 

 
N 
navigation in Amicus 7 

firm list customization 45 
Firm Members 2 

Password 4 
Profile 4 

Firm News 12 
Follow Up To Do’s 26 

 
G 
generating documents 41 
generating e-mail 41 
Groups (People) 47 

 
H 
Help 50 
Help Center 51 
HotDocs 41 

 
I 
integration with third-party products 43 
Intelligent Assistance. See DO buttons 
iPad 43 

 
K 
keeping informed 10 
keeping track of your time 16 

 
L 
Library module 29 
Linked Events 38 
links. See third-party products 
list default order 46 
login to Amicus 3 

 
M 
macro launching 37 
managing your client matter files 13 
matters. See Files 
meetings. See Appointments 

new item defaults 47 
Notes 30 

 
O 
Online Help 50 
order of items in lists 46 
organizing your practice 9 

 
P 
Paid Services 30 
Passwords 3 

changing 4 
People 

People Detail 24 
People Index 22 
People module 22 
Person’s role on the File 14 

Phone Calls 25 
Phone Messages 26 
posted and unposted Time Entries 17 
Precedents 39 
Priorities of To Do’s 46 

 
R 
Recurring Events. See Repeating Events 
reminders on a File 47 
reminders to call People 47 
repeating Events 48 
rescheduling an Appointment 19 
research 29 

 
S 
sharing an Amicus Office 35 
Stickies 30 

 
T 
Tasks module 21 
tasks. See To Do’s 
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telephone. See phone 
third-party products 43 
Time Entries 16 
Time module 16 
Time Sheets 17 
time slips. See Time Entries 
Timeline view of Tasks 21 
To Do’s 19 

See also Events; Calendar 
Today’s Overview 12 
Today’s Practice Reminders 10 
Tutorial Office 49 

 
U 
User Guide 51 
User Help 50 
User IDs 3 

 
W 
warnings 47 
web page in Dailies 12 
Word 41 
WordPerfect 41 
working together 35 
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